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Cisco DNS/DHCP Manager 1.1(2)
Release Notes
Introduction
These release notes contain important information about the Cisco DNS/DHCP Manager (CDDM)
V1.1(2).

These release notes are for use with the following manuals and contain information not included in
Cisco DNS/DHCP Manager Administrator’s Guide and Getting Started With Cisco DNS/DHCP
Manager.These release notes describe:

• New features and changes

• Important Notes

• Cisco Connection Online

New Features and Changes
This section describes new features in CDDM 1.1(2). The following topics are discussed:

• Platform support

• Distribution media changes

• Service configuration utility now called Cisco Service Manager (CSM)

• DHCP dynamic host name updates

• DHCP statistics utility

• Increased DHCP parameter support and improved configuration utility

• DNM Browser changes

• DNM import utility

• DNS Server changes

• NetControl server now called Master Server
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New Features and Changes
Platform Support
The CDDM 1.1(2) distribution includes CDDM and CSS1000 software for the following platforms:

• Windows NT

• Windows 95 (DNM Browser only)

• Solaris

• HP-UX

• IBM AIX (Power2)

• IBM AIX (PowerPC)

System Requirements
This section describes the hardware and software required to run CDDM 1.1(2) or CSS1000 1.1(2).

Windows NT Requirements

Windows 95 Requirements (Supports DNM Browser only)

CPU 90 MHz Pentium (133 MHz recommended)

Operating System Windows NT Workstation (Intel) 3.51 with Service Pack 5 or greater
Windows NT Server (Intel) 3.51 with Service Pack 5 or greater
Windows NT Workstation (Intel) 4.0 or greater
Windows NT Server (Intel) 4.0 or greater

RAM 32 MB of RAM (64 recommended)

Disk Space 50 MB of free hard disk space (100 recommended)

Monitor A monitor with 800 x 600 resolution, supporting 256 colors

CPU 90 MHz Pentium (133 MHz recommended)

Operating System Windows 95

RAM 32 MB of RAM

Disk Space 50 MB of free hard disk space (100 recommended)

Monitor A monitor with 800 x 600 resolution, supporting 256 colors
2 Cisco DNS/DHCP Manager 1.1(2) Release Notes



New Features and Changes
Solaris Requirements

HP-UX Requirements

IBM AIX Requirements

Distribution Media Changes
The Cisco Server Suite distribution has been renamed Cisco DNS/DHCP Manager.

Service Configuration Utility Now Called Cisco Service Manager
The service configuration utility called Service Configuration Manager (SCM) in CDDM 1.0 is now
called the Cisco Service Manager (CSM). The name change avoids confusion with the Windows NT
Service Control Manager (SCM).

CPU Sparc 5 (minimum), UltraSparc 1 (recommended)

Operating System SunOS version 5.4 (Solaris 2.4) or higher

RAM 32 MB of RAM (64 recommended)

Disk Space 50 MB of free hard disk space (100 recommended)

Monitor A monitor with 800 x 600 resolution, supporting 256 colors (for X clients)

CPU Any system shipped with HP/UX version 10.01 or higher

Operating System HP/UX version 10.01 or higher

RAM 32 MB of RAM (64 recommended)

Disk Space 50 MB of free hard disk space (100 recommended)

Monitor A monitor with 800 x 600 resolution, supporting 256 colors

CPU Power2 or PowerPC CPU

Operating System IBM AIX version 4.1 or higher

RAM 32 MB of RAM (64 recommended)

Disk Space 50 MB of free hard disk space (100 recommended)

Monitor A monitor with 800 x 600 resolution, supporting 256 colors
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New Features and Changes
DHCP Dynamic Host Name Updates
The DHCP/BootP server offers two ways to specify names for dynamic hosts:

For more information, see the exercises inGetting Started with Cisco DNS/DHCP Manager and the
DHCP/BootP configuration chapter in theCisco DNS/DHCP Manager Administrator’s Guide.

DHCP Statistics Utility
CDDM includes command-line utilities called dhcpstat (on Solaris, HP-UX, and AIX) and dhcpst32
(on Windows) that let you monitor outstanding leases of a DHCP server running locally or on a
remote host. For details on usage, see theCisco DNS/DHCP Manager Administrator’s Guide.

Increased DHCP Parameter Support and Improved Configuration Utility
The DHCP server now supports more parameters (option tags), such as those used by Microsoft
WINS clients. For descriptions of the new parameters, see the DHCP/BootP chapter in theCisco
DNS/DHCP Manager Administrator’s Guide.

The entry-ttl parameter has been replaced by the entry-ttl-percentage and entry-maximum-ttl
parameters.

The DHCP configuration editor in the Cisco Service Manager features a new user interface which
organizes DHCP parameters (option tags) into logical groups and makes it easier to create DHCP
and BootP entries that inherit parameters from other entries.

The BootP import function is no longer supported.

DNM Browser Changes
• The DNM Browser can now import multiple zone files in a single import operation.

• The DNM Browser now lets you view DHCP lease information for any node created by the
DHCP/BootP server. To view a node's DHCP information, select the node in the DNM Browser's
main window and choose Modify from the Edit menu. When the Add/Modify window appears,
click on the Display DHCP Information button under the Text Records field on the Basic tab. A
dialog box that appears displays the DHCP server host name and IP address, the DHCP client's
ID, hardware address, and hardware type, and the DHCP lease length, start time, and end time.

• The Connection tab in the Preferences dialog window now includes a Port parameter. Use the
Port parameter to make sure the DNM Browser sends DNM management commands to the DNM
server on the correct port. By default, both the DNM Browser and the DNM server use port 704
for management commands. To change the Port parameter for the DNM server, use the Cisco
Service Manager (CSM).

Method 1 Create a fixed set of host names based on a “base” name for each IP address pool
and propagate those names to the DNM server when a client accepts a lease.

Method 2 Let the DHCP client request a host name, and add a new domain name to the
DNM server when the client accepts the DHCP server’s offer. The DHCP/BootP
server only adds a name to the dynamic domain when a client accepts a lease.
Similarly, the DHCP/BootP server only deletes a name from the dynamic
domain when the corresponding lease expires or when the client releases it.
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New Features and Changes
DNM Import Utility
CDDM now includes a DNM client called dnm_import (on Solaris, HP-UX, and AIX) and
dnmimp32 (on Windows NT) that lets you import multiple zone files from a command line.
dnm_import also lets you import multiple zone files by specifying a standard BIND named.boot file.

DNS Server Changes
• The DNS server now appears in the CSM with the label “DNS” instead of “DOMAINNAME.”

• The CDDM’s DNS server is now based on BIND 4.9.5-P1. The new version improves the
server’s performance and improves security but it does not introduce any new features.

• The DNS Server now supports a Debug Level parameter which lets you control the amount of
debugging information it generates. The CSM lets you change the Debug Level parameter from
the Advanced tab in the DNS Server configuration editor’s Startup Tab.

NetControl Server Now Called Master Server
The NetControl server is now called the Master Server in the CSM.
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Important Notes
Important Notes
This section contains important information about using the Cisco DNS/DHCP Manager and Cisco
Server Suite 1000 products. The following topics are discussed:

• Installation changes

• Installation limitations

• Removing CDDM from Solaris, HP-UX, and AIX

• DNS server configuration file location

• Logging DNS Errors

• Master Server log files

• Starting applications

• Cisco Service Manager (CSM)

• Cisco Service Manager (CSM) limitations

• DHCP/BootP service

• Syslog service

• Domain Name Manager Browser and Server

• Closing CDDM utilities during redraws on Windows NT

• NTP service limitation on Windows NT

• Changing the Windows NT system host name

• Using Internet Explorer to read documentation

• Documentation errata

• Common error messages

Installation Changes
This section provides additional details on supported platforms and installation.

• CDDM 1.1(2) supports Windows NT 4.0 with Service Packs 1, 2, and 3, though none are
required. On Windows NT 3.5.1, CDDM 1.1(2) requires Service Pack 5.

• The Solaris version of the CDDM or Cisco Server Suite 1000 runs only on SPARC-based
computers running Solaris 2.4 or later.

• By default, all servers are configured to start manually after installation.

• After installing the DNM Browser on Windows 95, the installation prompts you to restart your
system.

• The CDDM no longer includes the ddm_config and ddm_xconfig utilities.

• If you need to install CDDM 1.1(2) on a system running CSS1000 1.1(2) or vice-versa, you must
remove the existing product before installing the new product. For information on removing
CDDM or CSS1000, seeGetting Started with Cisco DNS/DHCP Manager 1.1(2).

• The installation lets you configure your operating system to automatically start CDDM or
CSS1000 at system start-up.
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Important Notes
Installation Limitations
• During installation, do not include spaces in the pathname you specify as the installation

directory. For example, on Windows NT, do not specify a path such as
“C:\Windows\Program Files.” Similarly, on Solaris, HP-UX, or AIX, do not specify a pathname
such as “/usr /myhomedir.” In this release, including spaces in pathnames may adversely affect
your filesystem.

• If you upgrade from CDDM 1.0, the installation program lets you choose whether or not to merge
your 1.0 configuration with the CDDM 1.1(2) default configuration. If you install CDDM 1.1(2)
on a Windows NT system already running CDDM 1.1(2), and use the existing CDDM directory,
the installation program automatically merges your existing configuration files with the new files.
If you install CDDM 1.1(2) into a different directory, the installation program asks if you want
to merge the existing configuration files with the new files.

• When you install CDDM, the DNM server and DNS servers are both configured to use port 53
for zone transfers. If you plan to run the DNS server on the same system as the DNM server,
change the DNM server’s Nameserver-port parameter with the CSM. For details, see theCisco
DNS/DHCP Manager Administrator’s Guide.

• If you upgrade from CDDM or CSS1000 v1.0 to v1.1(2), the DHCP server assumes “Method 2”
DNM update behavior. As a result, the DHCP service does not delete its dynamic domain in the
DNM server when it restarts. You must manually delete the dynamic domain with the DNM
Browser. For details, see theCisco DNS/DHCP Manager Administrator’s Guide.

• If you plan to install Cisco TCP Suite 100 on the same system as CDDM or CSS1000, install
Cisco TCP Suite 100 first; CDDM installs updated versions of some files used by Cisco TCP
Suite 100. Installing Cisco TCP Suite 100 after CDDM replaces the newer versions with the older
versions, which prevents CDDM from running.

Removing CDDM from Solaris, HP-UX, and AIX
Before removing CDDM from Solaris, HP-UX, and AIX systems with the CDDM remove script,
make sure your current working directory is not under the installation directory. If you are under the
CDDM installation directory, the remove operation will not delete all of the CDDM directories.

Installing CDDM on Netra Systems
CDDM does not work on Netra systems unless you first install additional libraries. The extra
libraries required to get the Cisco Server Suite running on a Netra box are included on the Netra 3.1
RECOVERY CD which is supplied with all Netra's.

To install the files using the Netra browser interface:

Step 1 From the Netra Home page, select “Software Management” in System Administration
section.

Step 2 On the next page displayed check that the current installation medium is set to CDROM
(Netra 3.1 RECOVERY CD in drive). If not use “Select new installation medium” to
change.
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Step 3 Select “Packages” from Install section of page. This should jump to a page showing all
the packages available for install on the CD. The following packages need to be selected
for install:

• SUNWbcp

• SUNWsra

• SUNWscpu

Step 4 Once all the packages have been selected go to the bottom of the page & click “OK”,
Netra will install the three packages.

Step 5 Shutdown and restart the server and when it comes back up the LIBUCB library should
be in place and the Cisco Master Server should start.

DNS Server Configuration File Location
The DNS server configuration files have been moved from the servers/bind directory to the
config/bind directory.

Logging DNS Errors
DNS logs errors to the info.log file (even at debug level 0) each time DNS attempts to load a DNS
entry with an underscore (_) in its name. According to the DNS RFC, underscores are not valid in
DNS names. While BIND 4.9.5 tolerates underscores, future versions of BIND will not. The Cisco
DNS server generates warning messages if your names include underscores.

Starting Applications
This section provides additional information about starting CSM, the DNM Browser, and the Master
Server.

• Putting the executables directory in the Unix search path

Cisco recommends putting the path to the CSCOcddm/bin directory in your search path for
starting CDDM and Cisco Server Suite applications. This directory is located under your
installation directory.

• Applications automatically run in the background

Cisco Service Manager (CSM)
This section provides additional information about using the Cisco Service Manager (CSM).

• The CSM displays green circles in the Available Services list next to icons of services that are
running. When a service is stopped, the CSM displays a red circle. When the service is disabled,
the CSM displays no circle.

• The CSM may fail if certain fonts are not available on Solaris, HP-UX, and AIX systems acting
as your X Windows display. For example, the CSM requires fonts in the “common” font package.
To see which font packages are installed on a Solaris system, use the following command:

pkginfo | grep SUNWx

If the common package is installed, the above command output will include SUNWxwcf.
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Important Notes
If the common font package is not installed, insert the Solaris distribution CD-ROM and install
the font packages with the following command:

pkgadd SUNxwcf SUNwoft

For more details, see the pkgadd man page.

• The CSM does not provide scroll bars for text fields in the configuration editors. If you are unable
to see the complete text in a field, enlarge the CSM window or drag the pointer across the text.

• When you first open the CSM DHCP/BootP configuration editor screen, you may not see the
Add, Delete, Rename, and “arrow” buttons to the right of the Entries with Inheritance list
because the window is not wide enough. If these buttons do not appear, enlarge the CSM window.

Cisco Service Manager (CSM) limitations
This section describes known limitations, errors, and inconsistencies in the Cisco Service Manager
(CSM).

• The CSM is intended for use by only one user at a time. Because the CSM is an X client on Unix
systems, however, multiple users can run it at the same time. If multiple users run the CSM at the
same time, one user may accidentally overwrite another user’s changes.

• The CSM uses a portion of the system color map to display colors. When your system runs other
programs that also require a large portion of the color map, you may see a change in the colors
of the CSM. The color changes will in no way effect the CSM's functionality. On Unix systems
you can ensure that the CSM runs with its own colormap with the-colormap new command line
option.

• Graphics in the CSM may have inconsistent coloring on Windows NT systems configured to
display 256 colors.

• The status of services in the Available Services list may on occasion not reflect the real state of
the servers. To verify the state of the servers, click the newStatus button located below the
Available Services list.

• Configuring the NTP service with incorrectly formatted parameter values, such as invalid IP
addresses, can cause the CSM to crash.

DHCP/BootP Service
This section provides additional information about using the DHCP/BootP server.

• If you are using the DHCP/BootP service on networks that use Source Route bridging, such as
Token Ring networks, you must enable the DHCP/BootP service’s Use-broadcast startup
parameter with the CSM.

• The DHCP/BootP Server does not work on hosts with more than one IP address.

• The default SOA-refresh value (in the Parameters tab in the DHCP/BootP configuration editor’s
Startup tab) is below the minimum refresh interval required by BIND. If you use the Cisco DHCP
service to update a DNM server, make sure the SOA-refresh parameter is at least 900 seconds.

• The parameters entry-maximum-ttl and entry-ttl-percentage replace the entry-ttl parameter.

• The dnm-mode DHCP parameter lets you choose between Method 1 and Method 2 DNM
updates.
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Syslog Service
This section provides additional information about using the Syslog service.

• The Cisco Syslog server is provided primarily for troubleshooting services of the CDDM.

• The Cisco Syslog server does not implement the /dev/log interface provided by many operating
systems’ native Syslog servers. Native services can not log messages via the Cisco Syslog server.

• If you use entries from your operating system’s/etc/syslog.conf file to create entries in the Cisco
Syslog configuration editor, you must change the destinations of entries that have username
destinations.

Domain Name Manager Browser and Server
This section provides additional information about using the DNM Browser and DNM server.

• When you modify the records of a new or existing name with the DNM Browser on Windows
NT, the DNM Browser places the Main window in front of the Modify Records window.

• The DNM Browser uses a portion of the system color map to display colors. When your system
runs other programs that also require a large portion of the color map, you may see a change in
the colors of the DNM Browser. The color changes will in no way effect the DNM Browser's
functionality. On Unix systems you can ensure that the DNM Browser runs with its own
colormap with the-colormap new command line option.

• Graphics in the DNM Browser may have inconsistent coloring on Windows NT systems
configured to display 256 colors.

• Normally, the DNM Browser lists domains in alphabetical order. If you add a new domain that
includes dashes or numbers, it may not appear in alphabetical order initially. To restore
alphabetical ordering of the domain list, select the parent domain, then choose Reload from the
DNM Browser’s Edit menu.

• Because the Windows NT version of the DNM Browser takes a long time to display the splash
screen, you may want to launch the DNM Browser with the -nosplash command line option. To
customize the DNM Browser command in the Start menu to include the -nosplash command line
option:

Step 1 Open the Start menu with the right mouse button. Then select the Open All Users menu
item.

Step 2 When the Start Menu window appears, double-click on the Programs icon.

Step 3 When the Programs window appears, double-click on the Cisco Server Suite icon.

Step 4 When the Cisco Server Suite window appears, select the DNM Browser icon.

Step 5 Select the Properties menu item from the File menu.

Step 6 When the Domain Name Manager Browser Properties window appears, select the
Shortcut tab.

Step 7 Append/n  to theDNMBWR32.EXE in the Target field. For example:

C:\MULTINET\DNMBWR32.EXE /n

Step 8 Click onOK  in the Domain Name Manager Browser Properties window.
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• When specifying where you want files saved in the DNM Browser’s Export Zone Files and
Export Hosts Files windows, be sure you specify an absolute pathname in the Selection field or
select the directory with your mouse. If you accidentally enter a relative pathname, the DNM
Browser will save the file in the last directory specified with the mouse.

TFTP Directory Name Translations
The TFTP service’s Translation Rules entries in the CSM require special syntax to translate
directory names. For example, to translate /mydir to /home/doc/mydir, enter/mydir/*  in the Match
Spec field and enter/home/doc/mydir/  in the Translate Spec field.

NTP Service limitation on Windows NT
The CDDM NTP service on Windows NT does not support using the local clock as a reference.

Changing The Windows NT System Host Name
If you change your Windows NT system’s host name after installing CDDM or CSS1000, you must
also configure CDDM for the new name by manually updating the file C:\WINNT\MULTINET.INI.
For example, if you use the Network control panel to change the Computer Name field tomyhost ,
open C:\WINNT\MULTINET.INI, locate the HostName line in the [MULTINET] section, and edit
it to read as follows:

Host Name = myhost

Save the your changes to MULTINET.INI and restart the Master Server.

Using Internet Explorer to Read Documentation
Although CDDM supports Microsoft's Internet Explorer for viewing the HTML documentation files
it only supports Internet Explorer version 3.0 or higher. The latest version of Internet Explorer is
available at no cost from the Microsoft web site.

Documentation Errata
This section describes known errors and inconsistencies in the EFT documentation.

• In the chapter titled “Managing Zones with the DNM Browser” in theCisco DNS/DHCP
Manager Administrator’s Guide, the option called “Show pointer info in tree” is mistakenly
listed in the DNM Browser’s preferences screens. This item is in the Options menu.

• In the chapter titled “Summary of NTP Parameters” in theCisco DNS/DHCP Manager
Administrator’s Guide, the Debug Level parameter maximum value should be 100, not 10.
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Common Error Messages
This section describes error messages you may encounter while using CDDM or CSS1000.

Error Message
Get Interface Config: 22 won’t bind to individual interfaces

Explanation This message does not indicate any functional error. It appears because Windows NT
does not allow services to bind to individual interfaces, which prevents DNS from getting an
interface list. The message merely indicates that there will be no binding on every individual port
53, only on the generic port, 0.0.0.0.

Recommended Action None.

Error Message
DHCP: DoBootP: MAC address not found

Explanation This message appears when a BootP client on the network is looking for a server, but
no server has an entry for its hardware address.

Recommended Action If this message appears frequently you can change the DHCP server’s
debug parameter to 1 with the CSM (in the Parameters tab, under the StartUp tab). To eliminate the
problem that causes the message, you must either configure the BootP client to not use BootP or
configure a BootP server with an entry for the client’s hardware address.

Error Message DHCP; Static_BootP: bad hardware address length

Explanation This message may appear if there is a Microsoft RAS server on your network. The
message does not imply a CDDM malfunction.

Recommended Action None.

Cisco Connection Online
Cisco Connection Online (CCO), formerly Cisco Information Online (CIO), is Cisco Systems’
primary, real-time support channel. Maintenance customers and partners can self-register on CCO
to obtain additional content and services.

Available 24 hours a day, 7 days a week, CCO provides a wealth of standard and value-added
services to Cisco’s customers and business partners. CCO services include product information,
software updates, release notes, technical tips, the Bug Navigator, configuration notes, brochures,
descriptions of service offerings, and download access to public and authorized files.

CCO serves a wide variety of users through two interfaces that are updated and enhanced
simultaneously—a character-based version and a multimedia version that resides on the World Wide
Web (WWW). The character-based CCO supports Zmodem, Kermit, Xmodem, FTP, and Internet
e-mail, and is excellent for quick access to information over lower bandwidths. The WWW version
of CCO provides richly formatted documents with photographs, figures, graphics, and video, as well
as hyperlinks to related information.
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Cisco Connection Online
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You can access CCO in the following ways:

• WWW: http://www.cisco.com.

• WWW: http://www-europe.cisco.com.

• WWW: http://www-china.cisco.com.

• Telnet: cco.cisco.com.

• Modem: From North America, 408 526-8070; from Europe, 33 1 64 46 40 82. Use the
following terminal settings: VT100 emulation; databits: 8; parity: none; stop bits: 1; and baud
rates up to 14.4 kbps.

For a copy of CCO’s Frequently Asked Questions (FAQ), contact cco-help@cisco.com. For
additional information, contact cco-team@cisco.com.

Note If you are a network administrator and need personal technical assistance with a Cisco
product that is under warranty or covered by a maintenance contract, contact Cisco’s Technical
Assistance Center (TAC) at 800 553-2447, 408 526-7209, or tac@cisco.com. To obtain general
information about Cisco Systems, Cisco products, or upgrades, contact 800 553-6387,
408 526-7208, or cs-rep@cisco.com.
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